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Abstract - Our main aim is to develop a Centrifugal Impeller 

Prototype through 3D Printing, we may observe design 

parameters like Dimensions and Global variables. Whereas 

Speed, Scale, Weight, Time, and number of layers etc. in 3D 

Printing. We are going to model the material in Solidworks and 

then print it in Flashforge CreaterPro 3D Printer with ABS 

plastic as material. We will choose FDM in 3D Printing based 

on its special features like relatively fast, easy, and affordable 

method. Through this thesis, the manufacturing process of 

Impellers will advance to achieve high precision, complexity, 

less time consuming and low cost-effective. This method can 

be used in Jewellery making, Toys Industries, and customizable 

Gift Industries etc. 
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1. INTRODUCTION 

1.1 Background of Study 
Centrifugal impellers play a significant role in the 
manufacturing of machinery for several purposes in the present 
era of for different applications. They also play an important role 
in domestic products such as bore pumps, refrigeration units, 
and air conditioners etc. Manufacturing of Impellers is done by 
metallurgy techniques like sand casting, investments casting, 
die casting, CNC machining, etc. The major drawback of the 
centrifugal impellers manufactured using traditional methods 
known as metallurgical techniques is that they consume much 
time and need more workforce for production which is not a 
cost-effective technique. 

1.2 Problem Identification  
Manufacturing of impellers by conventional methods is time 
consuming. This may decrease the production rate and not be a 
cost-effective method. 

1.3 Significant of Project 
In the future, this could be a benchmark for further research on 
the manufacturing of impellers by 3D printing with the data we 
have established in this project. Companies as well as 
universities can use this research to update the design and 
uncertainty used when dealing with impellers and 3D printing. 

1.4 Objective  

The main objective of this project is to develop the Impeller 

model by using 3D printing. 

1.5 Scope of the Study 
The scope of the study will be on the modelling of Centrifugal 
Impeller through 3D printing. The work initially is to create a 
model of impeller by using modelling software. Then exporting 
to STL file format and there after choosing the required 
parameters for designing and preparing G-Code to move further. 
Finally, print the model for completion of the experiment. 

 

1.6 Relevancy of the Project 

• Giving the general knowledge of manufacturing through 3D 
printing. 

• To spread awareness that an advanced technology like 
prototyping can minimise the drawbacks of Traditional 
approach in designing and Modelling. 

• As a guideline to gain knowledge on development of 
Impeller through 3d printing.  

1.7 Feasibility of Project 
The project is feasible as it makes notoriously expensive, the 
creation of parts products cheaper and more accessible. As it 
results less wastage and no human errors with efficiently as 
well as the economically beneficial. The project is done by 
Fused Deposition Modelling method, which is low in cost, fast 
and brings huge benefits for the future. The time frame for the 
project is about. 

2.LITERATURE REVIEW 

Ramesh S. [1] 

By the reference of this Book (Rapid Prototyping), we have 
presented an overview of rapid prototyping technology. Part 
introduction and types of rapid prototyping. By the module we 
have got detailed information of 3D printing. All basic 
knowledge of Fused Deposition Modelling is pulled from this 
module. 

Robert R. Ross, Val S. Lobanoff [2] 

This book has valuable information on the elements of pump 
design, specific speed and modelling laws, and impeller design. 
Discussions focus on Impellers, classification of impeller, 
materials used, design parameters and design suggestions. 

Milos Teodor [3] 

By taking the reference of this paper we have concluded that 
computerized pump design has become a standard practice in 
industry, and it is widely used for both new designs as well as 
for old pumps retrofit. Such a complex design code has been 
developed over the past decade by the author. However, any 
design method must accept a set of hypotheses that neglect in 
the first design iteration the three-dimensional effects induced 
by the blade loading, as well as the viscous effects. As a result, 
an improved design can be achieved only by performing a full 
3D flow analysis in the pump impeller, followed by a suitable 
correction of the blade geometry and/or the meridian geometry. 

Farah Elida SELAMAT [4] 

This paper revolves around the idea of design and analysis of 
centrifugal Impeller for performance enhancement within the 
pump specifications. it can be observed that as the rotation speed 
of the impeller increases, the pressure within the impeller 
increases. The pressure increases gradually from impeller inlet 
to impeller outlet. It can also be observed that the efficiency of 
the impeller increases as the rotation speed increases. As a 
result, the performance of the impeller increases as the 
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efficiency increases. Performance of the impellers was 
compared based on inlet and outlet power, impeller efficiency, 
pressure distribution, and static head pressure produced. 

Anirudha S. Bhosale, P. N. Gore [5] 

In this paper model we have referred to the design parameter, 
working conditions and maximum efficiency with lowest power 
consumption. Study indicates that Computational fluid 
dynamics (CFD) analysis is being increasingly applied in the 
design of centrifugal pumps. Various parameters affect the 
pump performance and energy consumption. The impeller 
material, blade angle and the blade number are the most critical. 
Therefore, it is necessary for development in the impeller so we 
can improve the performance of pump. 

Syam Prasad, BVVV Lakshmipathi Rao, A Babji, Dr P 
Kumar Babu [6] 

It described the static and dynamic analysis of a centrifugal 
pump impeller which is made of three different alloy materials 
(viz., Inconel alloy 740, Nicolay alloy 803, Waspily) to estimate 
its performance. The investigation has been done by using 
CATIA and ANSYS13.0 software’s. A structural analysis has 
been carried out to investigate the stresses, strains and 
displacements of the impeller and modal analysis has been 
carried out to investigate the frequency and deflection of the 
impeller. An attempt is also made to suggest the best alloy for 
an impeller of a centrifugal pump by comparing the results 
obtained for three different alloys. 

Sambhrant Srivastavaa, Apurba Kumar Roy [7] 

In this module we have noticed the natural frequency and 
deformation of mixed flow pump impeller were evaluated 
considering two different blade positions in the meridional 
annulus. ANSYS was used for the investigation of natural 
frequency and deformation. It was observed that the mixed flow 
pump impeller with inlet inclined blade position in the 
meridional annulus was more suitable than the trapezoidal one. 

Matlakala [8]  

Centrifugal pumps contain two main parts: an impeller that 
imparts Centrifugal forces to the production fluid and diffuser 
which is the fixed part that guides the flow to the discharge. The 
shape of the impeller influences the performance of the pump. 
Thus, the area of the significance to the pump design is the 
impeller geometric parameters to achieve pump performance. 
The consumption of energy by the pump is caused by the failure 
to choose the right pump size for the system, improper 
installation, and pump operation. Poor pump performance may 
affect the plant operation such as maintenance cost, downtime, 
loss of production, increase in operating cost. 

Zhang, Yu. [9]  

This paper presents the optimization of vibrations of centrifugal 
pump considering fluid-structure interaction (FSI). A set of 
centrifugal pumps with various blade shapes were studied using 
FSI method, to investigate the transient vibration performance. 
The Kriging model, based on the results of the FSI simulations, 
was established to approximate the relationship between the 
geometrical parameters of pump impeller and the root mean 
square (RMS) values of the displacement response at the pump 
bearing block. 

Korakianitis, Theodosios. [10]  

Mechanical pumps as heart assist devices impose power and 
size limitations on the pumping mechanism, and therefore 
requires careful optimization of pump characteristics. Typically, 

new pumps are designed by relying on the performance of other 
previously designed pumps of known performance using 
concepts of fluid dynamic similarity. Such data are readily 
available for industrial pumps, which operate in Reynolds 
numbers region. 

3.EXPERIMENTATION 
3.1 Modelling of Centrifugal Impeller  

1. The geometric modelling of the Centrifugal impeller is 

done in Solid works Part Design. The design of geometry 

has the following steps:  

2. Open Solid works and choose the command File > New > 

Part.  

3. Select the system of units as MMGS and choose the 

sketch plane.  

4. Select the top plane from the Sketch tab and then select 

the line command and centreline tool and draw a centre 

line passing through the origin.  

5. Now select the top plane from the Sketch tab and then 

select the rectangle command and centre rectangle tool 

and draw a rectangle with dimensions >105 mm X >105 

mm (l x b) on the centre line passing through the origin.  

6. Now move the rectangle 90 mm away from the origin. 

7. Now select the Circular Sketch Pattern tool and select the 

corners of the rectangle and give 16 instances and click 

tick mark. 

8. Now exit the sketch. This results in sketch1 in tree bar 

diagram. Figure 15 and 16 shows sketch1 and 2 with 

dimensions in mm. 

9. Select the sketch1 and select Features tab and select 

Extrude Boss/Base tool and extrude blindly through 50 

mm. This is Boss- Extrude1 in tree bar diagram.  

10. Thus, the blades on the impeller are formed.  

11. Now select 3D Sketch on the Plane tool and select top 

plane and draw a circle of diameter 105 mm with the 

origin as the centre point.  

12. This will be 3DSketch1 in tree bar diagram. Figure 3 

shows 3DSketch1 with dimensions in mm. 

13. Now select 3DSketch1 and select Extrude Boss/Base tool 

and select extrude up to surface and select the surface of 

Boss – Extrude1 facing away from the origin. This is 

Boss- Extrude3 in tree bar diagram.  

14. Now select Chamfer tool in the Features tab and select 

all the circular edges as the Items to Chamfer and give 

chamfer parameters as 64 mm distance and use Tangent 

propagation and press tick mark.  

15. Thus, chmfer2 and chamfer3 features are formed.  

16. Now draw a hole on the impeller using the 3DSketch tool 

and Cut Extrude feature on the features tab.  

 

Impeller 3D Printing Procedure 

The pump impeller designed in Solid works is used to fabricate 

pump impeller using Flashforge3D Printer. The process is as 

follows:  
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1. The Solid works file containing Pump Impeller design is 

converted to. STL format and is exported to Flashforge 

workbench.  
The .STL file is opened in the Flashforge and resized to a scale 
82.25mm x 82.25mm x 20.83mm to fit within the 3D printing 
volume of the 3D printer.  

2. The model is meshed and prepared for 3D Printing.  

3. The Pump Impeller is printed in layers.  

4. Figure 22 shows the preview of the 3D print model. 

 

4. RESULTS 

Thus, the Centrifugal Impeller is manufactured using Additive 
Manufacturing technique. The nozzle of the Flashforge Creator 
Pro 3D Printer moves 144 times along the X axis and Z axis 
parallel to XZ plane. The time taken to print the scaled model of 
Pump Impeller is estimated around 3 hours. The material 
estimated for printing scaled model of Pump Impeller is 
estimated around 66.86 grams (0.15 lb.). 

Observations: 

Table1 shows the material properties. 

Model Scale 82.25mm x 82.25mm x 20.83mm 

Material 
Estimation 

66.86 grams 

Print time  2 hours 52 minutes 

Material ABS 

This is the Modelling procedure and Additive Manufacturing 
procedure for designing Centrifugal Impeller using Solid works 
Software and Flashforge3D Printer. 

 

 

5.CONCLUSION 

This study may result in the transforming the way of 
manufacturing the Centrifugal Impellers. There are various 
unique technological benefits of the 3D printing process which 
make it stand apart from other manufacturing techniques. The 

main advantages obtained from this study, Modelling and 
Additive Manufacturing of Impeller using 3D Printing as 
follows: 

1. The layering procedure of 3D printing considers a greater 

level of complexity, making it conceivable to print 

segments with complicated shapes and complex geometry. 

The pump impeller is fabricated as a single unit with no 

seam. 

2. No need of making patterns or using tools in additive 

manufacturing of the pump impeller which results in a 

reduction of the production costs. 

3. The model can be printed without the continuous 

surveillance and inspections.  

4. Continuous production made within less span of time 

sometimes in a matter of hours only. 

5. No need of finishing to product through 3D printing 

procedure. 
Therefore, by the study we have concluded that the pump 
impeller manufactured using the 3D Printing technique can be 
employed by the industries, by replacing the traditional 
manufacturing techniques. 

6.FUTURE SCOPE 

The centrifugal pump impeller modelled using Solid works and 
printed using Flashforge Creater pro Printer should be evaluated 
for its performance either using experimental analysis or the 
simulation studies. The printed model is a scale model and 
hence the results obtained during experimental analysis, or the 
simulation studies should also be scaled mathematically 
considering the principles, theory and the governing equations 
Dimensional Analysis and Simulation. The material used in this 
study is ABS Plastic which is quite enough for low discharge 
low-speed impeller pumps. The material should be changed in 
case of high discharge high-speed impeller pumps. 
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